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 General Operation 

Updated  Build Info File 
Purpose Report errors that have been corrected in the current build of CAMWorks 

2007. 

Implementation On the Start|Programs menu, select CAMWorks2007, then select Resolved 
CPR's. You can also open the file CW2007BuildInfo.rtf in the \lang\xxxx folder 
(where xxxx is the language: e.g., \lang\english) inside the CAMWorks 2007 
folder. 

New  Lock CAMWorks Data 
Purpose Provide ability to freeze or lock CAMWorks data for features, operations or the 

entire part model so the data cannot be modified. 

Implementation The Lock command has been added to the NC Manager, feature and operation 
shortcut menus. Multiple features and operations can be selected. Locked 
items are identified in a different color in the tree.  
• When the NC Manager is locked, the entire model is locked and any 

changes cannot be saved. You can still manipulate the tree views, change 
parameters, insert features, etc.  

• Locked features cannot be renamed or edited. Any command that does not
change the locked feature size or shape can be used (e.g., delete, reorder, 
hide, copy, suppress). If the Rebuild command is selected, a locked 
feature is not updated and toolpaths associated to the feature are not 
regenerated. During Rebuild, a new feature is created if the feature is 
different from the original. 

• For locked operations, any command that would modify the toolpath or 
operation parameters is disabled. Locked operations cannot be renamed. A
locked operation can be post processed, simulated, copied, deleted, 
reordered, suppressed, hidden, etc. 

Locked items can be unlocked by selecting Unlock Node on the shortcut menu. 
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New  Operation Recycle Bin 
Purpose Provide a Recycle Bin for deleted operations.  

Implementation A Recycle Bin has been added to the Operation tree. Only the operation and 
associated features links are stored with the deleted operation. The Recycle 
Bin shortcut menu includes commands to Restore All, Empty, Hide and 
Collapse Items. Operations in the Recycle Bin can be restored or removed 
using command on the operation shortcut menu. 

Improved  Feature Recycle Bin 
Purpose Move all deleted features to the Recycle Bin. 

Implementation When any feature created using AFR or IFR is deleted, CAMWorks moves the 
feature to the Recycle Bin. The features can be restored if necessary. In 
previous releases, only features found using AFR were stored in the Recycle 
Bin.  

Improved  Rebuild 
Purpose Prevent IFR features created during AFR, such as Face, Open Pocket and 

taper/fillet features from being rebuilt if in the Recycle Bin. 

Implementation Any feature in the Recycle Bin that was created using the options on the 
Features tab in the CAMWorks Options dialog box will not be restored to the 
Setup when Rebuild is run.  

Improved  Stock Outline, Setup Origin Display 
Purpose Provide an option to display the stock outline continuously and automatically 

display the Setup origin. 

Implementation The Show stock outline option is on the Display tab in the CAMWorks Options 
dialog box. When this option is selected, the stock displays continuously. 
When not selected, the stock displays only when the stock item is selected in 
the tree. 
The Setup origin displays automatically when a Feature or Operation is 
selected in the tree and during simulation.  

Improved  Saving Files With Large Amount of Toolpaths 
Purpose Improve performance. 

Implementation The time required to save files with a large amount of toolpaths has been 
reduced significantly. This is most noticeable in parts with 3 axis toolpaths. 

New  Display Main Parameters for Operations 
Purpose Display main parameters for the selected operation in the tree.  

Implementation The Display tool tip for operation parameters option has been added on the 
Display tab in the Options dialog box. When this option is checked and the 
cursor is placed over an operation in the tree, the main parameters for the 
operation display in the graphics area.  
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Improved  OpenGL Display Options 
Purpose Provide additional OpenGL options to control the display of CAMWorks 

features and toolpaths in SolidWorks.  

Implementation The OpenGL option on the Display tab in the Options dialog box provides 
choices: 
None - CAMWorks does not use OpenGL and displays all the edges. Using one 
of the OpenGL options can improve performance. 
Wireframe - CAMWorks uses OpenGL and displays all feature and toolpath 
edges.  
Hiddenline - CAMWorks uses OpenGL and displays only those edges that are 
visible at the chosen angle. Obscured lines are removed (HLR).  

New  Go To Commands for Locating Features and Operations  
Purpose Provide a method to quickly locate instances of a features and operations 

generated for a feature.  

Implementation Right click on a feature in the Feature or Operation tree, select Go To on the 
shortcut menu, then select:  
Feature Instances ... 
A list displays of all instances of the feature. When an instance is highlighted 
in the dialog box, the corresponding feature item is highlighted in the Feature 
tree.  
Operations For ... 
A list displays of all operations generated for this feature. When an operation 
is highlighted in the dialog box, the corresponding operation item is 
highlighted in the Operation tree. 
Note: The Go To First Operation command is no longer needed and has been 
removed.  

Improved  Insert Operations 
Purpose Allow Mill, Turn and Wire EDM operations to be inserted even if Setups and 

Features do not exist and simplify user interaction.  

Implementation The following changes have been made: 
• The Insert Operation dialog box has been modified to allow inserting 

Setups and Features.  
• In Mill, the Insert Operation dialog box for 2.5 axis, hole operations, 3 axis 

operations and 5 axis operations now uses a common interface.  
• Insert operation command buttons have been added to the CAMWorks 

toolbar. The CAMWorks toolbar for Mill is shown below. 

   

Improved  Apply to All Implemented for Additional Mill Operation Parameters 
Purpose Provide additional Apply To All buttons that apply the current Mill operation 

parameters in a group box to all features in the operation. 

Implementation 
 An Apply to All button has been added for the following groups of 

parameters: 
• Rough Mill Operation, Feature Options tab: Entry type, Entry point, Retract 

point 
• Contour Mill Operation, Feature Options tab: Entry type 
• Contour Mill Operation, Side Parameters dialog box: all parameters in the 

dialog box 
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Improved  Mill Spindle Speed 
Purpose Provide an option to lock the spindle speed so that the RPM value will not 

update when the tool diameter changes. 

Implementation On the F/S tab in the Operation Parameters dialog box, enable the Lock 
spindle speed option.  The default for each operation can be defined in the 
Technology Database. 

New  Support for Multiple Machine Types in One File 
Purpose In Part mode, allow multiple machine types to be supported in one file with 

support for SolidWorks configurations.  

Implementation Multiple CAMWorks datasets are supported in Part mode. Each dataset is 
called a configuration. You can use configurations to support multiple 
machines and SolidWorks configurations. 

 When you double-click the Configurations item in the tree or right click and 
select Manage Configurations, the CAMWorks Configurations Manager dialog 
box displays. You can activate a different configuration, create new 
configurations, delete and copy configurations. 
Note: Multiple machine support will be implemented for  Assembly mode in a 
future release. 

Improved  Hidden Feature and Operation Display 
Purpose Display hidden features and operations in a different, user-definable color. 

Implementation Hidden features and operation items display in a different color in the Feature 
and Operation trees. The color can be changed on the Display tab in the 
CAMWorks Options dialog box. 

New  Options for 4th and 5th Axis Indexing 
Purpose Provide the ability to define a Fixture Coordinate System in Part mode for 4th 

and 5th axis indexing. 

Implementation The Fixture Coordinate System parameter has been enabled in Part mode on 
the Setup tab in the Machine dialog box. You can pick the Fixture Coordinate 
System and identify it rotates around an axis of the coordinate system. The 
axis and the 0 degree position on the 4th Axis and 5th Axis tabs can be based 
on the Fixture Coordinate System. 

Improved  G-code Output for Hog and Ball Nose tools 
Purpose Allow G-code output for ball nose, hog nose, tapered ball nose and tapered 

hog nose tools to be output at the tool tip or the tool center. 

Implementation For any 2 or 3 axis operation that supports ball and hog nose tools, the Mill 
Tool tab in the Operation Parameters dialog box contains an option to Output 
through Tip or Center. 

  
Output through tip Output through center 
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 Mill Features 

New  Manufacturing View (MfgView) Feature Recognition 
Purpose Provide a new generation of automatic feature recognition that finds additional 

feature types and allows features to be edited. 

Implementation A Method option has been added on the Mill Features tab in the CAMWorks 
Options dialog box. When MfgView is selected, CAMWorks uses a new method 
to generate features. Non-hole features can be edited the same as 
interactively inserted features.  

New  Automatic Feature Recognition from Setup Level 
Purpose Provide the ability to recognize Mill features from a user-defined direction 

only. 

Implementation When the Method on the Mill Features tab is set to MfgView, you can right 
click a Mill Part Setup and select Recognize Features. 

Improved  Associate Any Mill Feature 
Purpose Provide an option in the Associate Features dialog box to associate any Mill 

features to current features, not just features that do not rebuild. 

Implementation The Associate Features command is always enabled on the NC Manager 
shortcut menu. An All features option has been added in the Associate 
Features dialog box. When this option is not checked, the dialog box lists only 
features that cannot be rebuilt. When checked, all existing features are listed. 

New  Support for Wrapped Features in Mill 
Purpose Provide support for Wrapped features in Mill mode. 

Implementation Wrapped features, previously supported only in Mill-Turn, can be inserted in 
Mill under the following conditions: 

• A Rotary Milling license is required. 
• The current Mill Setup must be perpendicular to the 4th axis. 

• Indexing must be set to 4 Axis on the Setup tab in the Machine dialog 
box.  

• A Fixture Coordinate System has been enabled in Part mode and must 
be specified on the Setup tab in the Machine dialog box.  

• The X or Y axis of the Fixture Coordinate System must be selected to 
define the 4th axis. 

• Faces/edges used to define the Wrapped feature must be cylindrical. 
• The axis of the cylindrical faces/edges must be coincident with the 4th 

axis. 

 
 2.5 Axis Milling 

Updated  Finish Mill Renamed Contour Mill 
Purpose Change label for Finish Mill operation to more accurately identify capabilities. 

Implementation The label for Finish Mill in the Operation tree has been changed to Contour Mill 
and the Finish tab in the Operation Parameters dialog box has been changed 
to Contour. 
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Improved  Contour Mill Options for Multiple Cut Depths and Side Passes 
Purpose Provide options to reduce and eliminate unnecessary moves when contour 

(finish) machining features with multiple depths and side passes. 

Implementation • When machining features with multiple cut depths and/or side passes, it 
may be more efficient to reverse the cut direction from cut depth to cut 
depth and/or from side pass to side pass. 
A Zigzag option has been added in the Depth processing section on the 
Contour tab and in the Side Parameters dialog box. On the Contour tab 
when Depth processing is set for To depth by region and this option is 
checked, the tool moves down in Z without retracting and machines in 
the opposite direction. When checked in the Side Parameters dialog box, 
the tool reverses direction from side pass to side pass.  

• Cut depth and Side passes parameters have been added to the Leadin 
tab to specify how to link one depth to the next and one side pass to the 
next: Retract to Clearance, Stay Down or Direct (for side passes). When 
Stay Down is selected, the Feedrate for the feed move that joins the 
current leadout to the next leadin can be defined as a value or as a 
percent of the XY feedrate value on the F/S tab. 

Improved  Contour Mill Compensated Toolpath Output 
Purpose Provide compensated toolpath output for Contour Mill operations when the 

toolpath center is set to Without compensation. 

Implementation Done automatically for Contour Mill operations when the NC parameters are 
set to: 
CNC compensation = On 
Toolpath center = Without compensation 
In previous releases, the CL that was output to posting is not correct for some 
cases and other cases the machine tool would misinterpret the output and 
generate incorrect moves on the machine. The method for the toolpath that 
was output to the CL file was to effectively convert the feature geometry to CL 
records. In some cases this output was processed properly by the machine 
tool, but in some cases it was not and the machine tool would incorrectly cut 
the part.  
CAMWorks can now output CL data to correctly cut the part for the following 
cases: 
• When the corner radii are smaller than the sum of the tool radius and XY 

allowance many machines will not generate the proper toolpath. 
• When islands and/or the feature perimeter would merge into a single 

shape when machined or when the shape that results would be two 
areas instead of one. 

• Where the XY allowance is negative and for tapered and filleted 
features.  
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 3 Axis Milling 

Updated  Labels for Advanced 3 Axis Operations Simplified  
Purpose Change labels for Advanced 3 Axis operations to simplify names and more 

accurately identify capabilities. 

Implementation The labels for Adv. 3 Axis operations have been changed as follows: 
Adv. 3 Axis Rough -> Area Clearance 
Adv. 3 Axis Z Level -> Z Level 
Adv. 3 Axis Pattern Project -> Pattern Project  
Adv. 3 Axis Stepover -> Constant Stepover 
Adv. 3 Axis Curve Project -> Curve Project 
Adv. 3 Axis Flat Area -> Flat Area 

Improved  Arc fitting for all 3 Axis Mill operations 
Purpose Provide the ability to generate toolpaths comprised of line and arc moves for 

all 3 Axis Mill operations. 

Implementation Arc fitting options are on the Advanced tab in the Operation Parameters dialog 
box for all 3 Axis operations (except 3 Axis Rough and 3 Axis Finish). Previous 
releases supported arc fitting for Area Clearance, Z Level and Flat Area only.  
Using Arc fitting can be beneficial even when the machine does not support 
circular interpolation and your post does not support it. When arc fitting is 
used, less memory is required for the display, the CAMWorks file size is 
smaller and simulation is faster especially in Tool mode. In benchmark testing 
on some parts, the CAMWorks toolpath size was almost 6 times smaller and 
the simulation was almost 4 times faster. 

 
 Multiaxis Machining 

Improved  Spiral pattern cutting 
Purpose Provide the ability to generate spiral toolpaths for all patterns. 

Implementation The Change parallel cuts to spiral option on the Advanced tab previously 
supported only the Slice pattern. This option can now be selected for all 
pattern types on the Pattern tab. 

New  Side Tilt Strategy when tool axis is tilted relative to the cutting direction  
Purpose Provide an additional side tilt strategy when the tool axis is tilted relative to 

the cutting direction. 

Implementation On the Axis Control tab, when using Tilted Relative to Cutting Direction for the 
tool axis cutting direction tilt, the option Use Tilt Line Definition has been 
added to the list of options for the Side tilt strategy.  
When this option is selected, you can select lines to define the side tilting 
direction. 

New  Line Tilt Strategy when tool axis is tilted through lines  
Purpose Provide an additional line tilt strategy when the tool axis is tilted through 

lines. 

Implementation On the Axis Control tab, when using Tilted Through Lines for the tool axis 
cutting direction tilt, the option Always Closest Two Lines is now supported for 
the Line tilt strategy.  
When this option is selected, CAMWorks approximates the direction of the tool 
axis using the two closest lines. The result is that the tool axis will have the 
same orientation as the tilt axis.  
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New  Roughing options  
Purpose Provide an additional options on the Roughing tab. 

Implementation New options have been added to the Roughing tab: 
Connect by shortest distance  
When this option is checked, CAMWorks uses the shortest distance to the next 
cut.  
Tangent ramping 
The option is enabled when Axial cut depths is selected. When this option is 
checked, CAMWorks changes the single slices to one spiral slice. The order is 
starting from the roughing passes to the finishing passes. The tool starts and 
stops on the same position.  

 
 Assembly Mode 

New  Machining of SolidWorks Part Configurations in Assembly Mode 
Purpose In the Part Manager, identify parts based on the combination of the part name 

and the configuration name so that multiple configurations of a part can be 
machined at the same time. 

Implementation In the Part Manager, when a part model is selected, it will be identified in 
CAMWorks as well as Part Manager with both the part name and part 
configuration. Multiple instances of the same part name/configuration name 
will still be supported. When AFR is run, it will be run for each different 
combination of part name/configuration name. 

New  Split Instances of Same Part 
Purpose Provide ability to split instances of the same part and generate separate 

features and operations for each instance. 

Implementation In the Part Manager, when a part model is selected, click the Split Instances 
button. When AFR is run, separate instances of each feature are generated. 
Separate operations are also generated. This option can be used when more 
flexibility is required (e.g., when sequencing operations or machining features 
differently). 

Improved  Assembly Mode Feature Names 
Purpose Simplify identifying a feature in the Feature Manager with the corresponding 

feature in a Setup. 

Implementation If a feature is renamed in the Feature Manager, the feature name in the Setup 
is changed automatically. 

 

 Turning 

New  Associate Turn Features 
Purpose Provide an option to associate new Turn features to current Turn features. 

Implementation Select Associate Features on the NC Manager shortcut menu. In the Associate 
Features dialog box, check the All features option. Highlight a Current feature 
and click Associate. Select Add to generate operations for the new feature that 
are copies of the operations generated for the selected Current feature. Select 
Replace to replace the selected Current feature with the new feature in every 
operation that contains the Current feature and delete Current feature from 
the Feature tree. 
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Improved  Turn Cutoff Chamfer Extension 
Purpose Provide the ability to specify a chamfer extension distance to increase the 

width of the toolpath for machining the chamfer. 

Implementation A new Chamfer ext. option on the Cutoff tab in the Operation Parameters 
dialog box allows you to define a distance above the diameter of the cutoff 
feature where the chamfer will start. You can use this option to eliminate 
small bumps that may occur at the top of the chamfer due to tool wear or the 
diameter of the stock not being exactly the same as the feature diameter. 

Improved  Turn Cutoff Slowdown Option 
Purpose Provide the ability to decrease the speed and feedrate at a user specified 

length from the end of a cutoff toolpath. 

Implementation Options have been added to the Cutoff tab in the Operation dialog box to 
reduce the spindle speed and feedrate at a specified distance from the end of 
the Cutoff feature.  

New  Rough Groove Cleanup Pass 
Purpose Provide an option to generate a cleanup pass in rough grooving to remove 

scallops generated by the rough groove toolpath. 

Implementation The following options on the Rough Groove tab allow you to define whether to 
generate a cleanup pass and what method to use: 
Cleanup pass 
• None - No cleanup pass is generated. 
• From WIP - Cleanup pass is generated based on the WIP model. 
• Full Groove - Cleanup pass is generated for the entire groove shape. 

Previous allowance -The perpendicular distance between the original (uncut) 
and final surfaces of the stock. 
Cut amount - Defines how deep the cut is. If the Previous allowance is larger 
than the Cut amount, more than one pass is generated. 

New  Finish Groove Cutter Compensation 
Purpose Support cutter compensation for Finish Groove toolpaths. 

Implementation • In order to generate the leadins and leadouts needed for machine 
compensation, the Leadin/Out tab has been added to the Finish Groove 
operation.  

• On the Finish Groove tab, an option allows you to specify whether to 
output compensation codes in the NC program. 

New  Groove Tool Driving Point 
Purpose When using a groove tool for a turn toolpath, provide options to define the 

driving point of the groove tool. 

Implementation CAMWorks computes and displays the toolpath as if the driving point is at the 
center of the insert. However, in many cases the XZ point coordinates in the 
G-code output must be at the edge of the insert. CAMWorks provides several 
options for controlling the output driving point on the groove tool.  
A Driving point option has been added for all operation types that support 
groove tools (e.g., Rough Groove, Finish Groove, Cutoff, Rough Turn, Finish 
Turn). 
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Improved  Turn Thread End Length Parameter 
Purpose Provide an end length parameter to increase the length of the Thread 

toolpath. 

Implementation The End length parameter on the Thread tab in the Operation Parameters 
dialog box defines an incremental amount to add to or subtract from the end 
of the feature length and the resulting toolpath. 

Improved  Turn Thread Chamfer Angle Parameter 
Purpose Allow a user-defined Chamfer angle. 

Implementation New options on the Thread tab in the Operation Parameters dialog box allow 
you to specify a chamfer with a user-defined angle. 

New  Set Minimum and Maximum Z Limits for Turn Operations 
Purpose Provide the ability to set an absolute machine depth for Turn operations. 

Implementation User-defined Z limits can be set globally on the Advanced tab in the Part 
Setup Parameters dialog box or for each operation on the Advanced tab in the 
Operation Parameters dialog box.   

 
 Technology Database 

New  TechDB Support for Wire EDM 
Purpose Provide TechDB support for Wire EDM features and operations. 

Implementation An EDM section has been added to the TechDB that allows you to define user-
defined attributes, EDM stock materials, and EDM features and operations.  
Note that EDM Machines are not defined in the TechDB. They are defined in 
CAMWorks as in previous releases.  

New  Set Defaults for New Operation Parameters 
Purpose Provide options to set defaults for operation parameters added in CAMWorks 

2007 for all modules.  

Implementation The default values for operation parameters added in this release can be 
defined on the applicable forms in the TechDB. 

 
 Simulation 

New  Reverse Toolpath in Tool Mode 
Purpose Provide a simulation control to reverse the toolpath while in Tool mode. 

Implementation 
 During simulation, a Reverse step button is enabled on the Toolpath 

Simulation toolbar for Mill, Turn, Mill/Turn and Wire EDM. When selected, the 
tool moves backward one CL record for each time the button is clicked. 
The Simulation tab in the CAMWorks Options dialog box includes an option to 
specify the maximum number of cuts where material can be added to the 
stock while in Reverse step mode. Note that when using this option, Tool 
mode simulation will be slower by about 15%. As the number of allowed steps 
to add material is increased, more system memory is also required. A large 
number could result in an out of memory condition and further slow down 
simulation. 
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New  Section View of Simulated Mill or Wire EDM Part 
Purpose Provide functionality to create a section view of a simulated Mill or EDM part. 

Implementation 
 A Section view button has been added to the Toolpath Simulation toolbar 

for Mill and Wire EDM. When the Section View button is clicked, you can 
customize the section view by selecting a CAMWorks plane that the section 
plane will be parallel to and picking an entity to define the section plane.  

Improved  Simplified Turn Thread Simulation Option 
Purpose Provide an option to simulate a turn thread in a simplified form to improve 

performance. 

Implementation The Simplified threading option on the Simulation tab in the CAMWorks 
Options dialog box can be used to simulate a thread in a simplified form to 
improve performance. When this option is not checked, CAMWorks simulates 
the full thread, which can result in very slow simulation speeds. When this 
option is checked, CAMWorks simulates the thread as if the cut is a normal 
turning cut and thread simulation should be much faster.  

Improved Setup Origin Display During Simulation 
Purpose For Mill and Wire EDM, provide an option to automatically display the Setup 

origin during simulation. 

Implementation Done automatically.  
 
 Posting / UPG 

New  CAMWorks Turn System Variables 
Purpose Provide additional system variables for CAMWorks Turn.  

Implementation Support for new variables has been added for CAMWorks 2007 Turn. Post 
customization is required in order to use these variables.  
For more information, install the UPG from the CAMWorks 2007 CD, start the 
UPG and select Complete Reference Guide on the Help menu. This information 
is also in the Post Processor Writer's Reference on the Miscellaneous Files 
downloads page on the TekSoft website. 

 
 Wire EDM 

New  TechDB Support 
Purpose Provide TechDB support for Wire EDM features and operations. 

Implementation An EDM section has been added to the TechDB that allows you to define user-
defined attributes, EDM stock materials, and EDM features and operations.  
Note that EDM Machines are not defined in the TechDB. They are defined in 
CAMWorks as in previous releases.     

New  Feature Attributes 
Purpose Provide support for feature attributes. 

Implementation Assigning an attribute to an EDM feature is similar to assigning Mill feature 
attributes. This includes automatic assignment for AFR features and 
assignment of attributes in the Insert 2.5 Axis EDM Feature and Insert 4 Axis 
EDM Feature dialog boxes. A new Feature Parameters dialog box allows you to 
change the attribute for the selected feature.  
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New  Associate EDM Features 
Purpose Provide an option to associate new EDM features to current EDM features. 

Implementation Select Associate Features on the NC Manager shortcut menu. In the Associate 
Features dialog box, check the All features option. Highlight a Current feature 
and click Associate. Select Add to add the new feature to all operations for the 
selected Current feature. Select Replace to replace the selected Current 
feature with the new feature in every operation that contains the Current 
feature and delete Current feature from the Feature tree. 

New  Separate Leadin/Leadout for Rough and Skim Cuts 
Purpose Allow separate leadin/out methods for the EDM Rough/Glue Stop passes and 

for the Skim/Glue Stop passes. 

Implementation For 2 Axis and 4 Axis Contour operations, options have been added on the 
Leadin/Out tab that allow you to apply the same leadin/leadout method to 
rough and skim passes or apply a separate leadin/leadout to rough and skim 
passes. 

Improved  Output Options 
Purpose Provide the ability to output rough cuts only, tab cuts only, or rough and tab 

cuts. 

Implementation For 2 Axis and 4 Axis Contour operations, an Output option on the EDM tab 
allows you to select Rough cut and/or Tab cut. 

New  Automatic Punch and Die 
Purpose For 2 Axis Contour operations, provide an option to automatically generate 

toolpath passes that will cut both a die and punch at the same time. 

Implementation For 2 Axis Contour operations that are machining a 2 Axis die feature with no 
taper, the One Cut Punch & Die option can be selected in the Land and taper 
section on the EDM tab.  

New  Option for G-code to Output an Offset Toolpath 
Purpose Provide the ability for the G-code to output to the wire center. 

Implementation In previous releases, except for coreless toolpaths, all G-code output for 2 
axis and 4 axis toolpaths was to the feature geometry, which required that all 
compensation be performed on the machine tool control. For various reasons, 
it is sometimes required that the G-code output XY values to the wire center 
and per offset pass. 
The Posting tab in the 2 Axis and 4 Axis Contour dialog boxes has a Toolpath 
center option that defines whether the G-code output should be to the wire 
center (With compensation) or the feature geometry (Without compensation).  
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